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INTRODUÇÃO 
 
 
Este documento descreve os recursos que o SimulationView oferece ao usuário. 
 
O SimulationView – Simulador de estratégia de controle é uma ferramenta de software 
desenvolvida especialmente para fazer a simulação de estratégias de controle com blocos 
funcionais FoundationTM fieldbus e lógica ladder padrão IEC 61131-3. 
 
Integrado ao SYSTEM302  

• Não é necessário exportar configurações para simulação;  
• Busca dados diretamente do banco de dados do SYSTEM302;  
• As ferramentas do SYSTEM302 usam a simulação de forma automática e transparente; 

 
Comunicação via OPCTM  

• Os dados simulados são visíveis através do Server OPCTM do SYSTEM302;  
• Qualquer software supervisório e SCADA baseado na tecnologia OPCTM pode se 

beneficiar da simulação.  
 
O SimulationView opera com os sistemas Windows da Microsoft®. 
 
Este manual refere-se à versão 1 do SimulationView disponível no SYSTEM302 versão 8.2. 
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Seção 1 
 

1.1 

INSTALAÇÃO E CONFIGURAÇÃO 
 

Instalação 
 
O SimulationView é instalado pela mídia de instalação do SYSTEM302, juntamente com todos os 
outros aplicativos necessários para configurar, gerenciar e supervisionar o controle de sua planta. 
 
Consulte o manual Guia de Instalação do SYSTEM302 que descreve os procedimentos de 
instalação do SYSTEM302. 
 
Após instalar o SYSTEM302 obtenha a licença de uso do SimulationView - Strategy Simulator.  
 
 

Obtendo a Licença de Uso 
 
Existem duas maneiras de se obter uma licença para uso do SimulationView. Uma versão é com 
proteção via Hard Lock (HardKey) e outra via software (SoftKey). 
 
A versão HardKey já vem pronta para uso, bastando conectar o dispositivo à porta apropriada 
(paralela ou USB) do computador.  
 
Para uso da proteção via software é necessário obter uma License Key, entrando em contato com a 
Smar. Para tanto use o aplicativo LicenseView localizado na interface do Studio302. 
 
Selecione Softkey e, em seguida, Request License. 
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Preencha os campos corretamente, informe o código LN (License Number) que foi recebido com a 
compra do produto. Veja este código no chaveiro que acompanhou a mídia de instalação. Um 
arquivo (.zip) será gerado na pasta \Smar\OleServers para que o usuário envie para a Smar. 
Utilize o e-mail (techsupport@smar.com.br) ou acesse o canal de Suporte técnico através do site 
(www.smar.com.br). 
 
Após enviado o e-mail para a Smar, uma chave de liberação será gerada de acordo com o nível do 
LN correspondente. Esta chave será retornada através do e-mail de retorno informado na 
requisição anterior. Esta geração não é automática e, portanto, deve-se aguardar o horário 
comercial. 
 
Após recebido o e-mail da Smar, abra novamente o aplicativo LicenseView, insira a chave obtida 
no campo DFI OLE Server e clique em Grant License Keys. Se tudo estiver correto, uma 
mensagem avisará que a licença foi aceita. 
 

NOTA 
A Licença Acadêmica tem algumas limitações. Para o modo de simulação as 
ferramentas Syscon e LogicView for FFB, incluídas no pacote, somente podem 
acessar um server OPC local. O acesso remoto é bloqueado para licença acadêmica. 
Para mais detalhes sobre licenças refira-se ao Guia de Instalação do SYSTEM302. 

 

Iniciando o SimulationView 
 
Para iniciar a simulação é necessário executar o SimulationView. 
 

Na barra de ferramentas do Studio302 clique em  - SimulationView - Strategy Simulator.  
 
Caso o botão não esteja ativado, verifique as preferências em File →Preferences. Clique na aba 
SimulateView e marque a opção Enable the System302 simulation mode.  
 
No entanto, para trabalhar com o SimulationView primeiro é necessário criar um novo adaptador 
de rede e configurá-lo. Veja o tópico seguinte. 
 

Configuração 
 
Para trabalhar com o SimulationView é necessário criar um novo adaptador de rede. Este 
adaptador será usado exclusivamente para simulação, ficando isolado da rede de controle ou 
corporativa. Ou até mesmo, permitindo que você trabalhe em uma máquina que não tenha, sequer, 
uma conexão de rede. Este adaptador será criado automaticamente pelo aplicativo IP Configurator 
na primeira vez que for executado. Caso aconteça algum erro e a interface não seja criada 
automaticamente refira-se ao Anexo A para obter o procedimento de criação manual da mesma. 
 

Setup tool 
 
A cada execução do SimulationView a ferramenta de setup será executada para verificação da 
configuração. São elas: 
 
Verificação do Banco de dados 
Para que o SimulationView execute é necessário que o Database possua pelo menos uma área, 
caso contrário, a seguinte janela aparecerá. 
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Crie uma área e tente novamente executar o SimulationView. 
 
Verificação da licença 
O Setup tool verifica a presença de uma licença para a execução do SimulationView. Caso 
nenhuma hardkey compatível seja encontrada ou uma softkey o Setup tool não permite que o 
SimulationView seja executado. 
 

 
 
A figura acima mostra falha na verificação da licença. Conecte uma hardkey ou obtenha uma 

softkey e clique no botão  para uma nova verificação. Caso já tenha fechado o Setup tool 
execute novamente o SimulationView. Para mais informações consulte o tópico Obtendo a licença 
de uso. 
 
Verificação de rede 
O Setup tool verifica a existência de um adaptador de rede do tipo Microsoft Loopback Adapter 
propriamente instalado. 
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Caso ele não exista será mostrada a falha na detecção do adaptador de rede pelo Setup tool como 

na figura acima. Clique no botão  para iniciar o IP Configurator. Para mais detalhes sobre esta 
ferramenta veja o tópico IP Configurator. 
 
Verificação da configuração OPC 
O Setup tool verifica a configuração do servidor OPC Smar. Esta verificação consiste na 
comparação do NIC com o IP configurado na ferramenta IP Configurator como First IP. 

 

 
 
 

A janela acima mostra o NIC configurado para um adaptador de rede diferente do usado para 

simulação. Clique no botão  e o NIC será configurado com o IP correto e o simulador estará 
pronto para ser executado. O Setup tool aparecerá como na figura seguinte. 
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A janela acima mostra a configuração pronta para execução do SimulationView. Marque a opção 
Close and run SimulationView when ready para executar automaticamente o SimulationView 
caso a configuração esteja correta. Mesmo com esta opção marcada o Setup tool vai parar a 
execução do SimulationView quando detectar alguma inconsistência. 

 
Caso aconteça algum problema com Database e o mesmo não for detectado aparecerá a janela 
seguinte. Neste caso tente reiniciar o Database ou reiniciar o computador. 

 

  
 
 
IP Configurator 
 

A ferramenta IP configurator pode ser iniciada pelo ícone  na interface do Setup tool ou na 
tela principal do SimulationView. 
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A seguinte janela abrirá confirmando que o SimulationView será fechado para iniciar o IP 
Configurator. Clique Yes. 
 

 
 
A ferramenta IP Configurator é usada para configurar os IPs que serão usados na simulação. Veja 
no tópico seguinte como ela é usada para configurar a interface Microsoft Loopback Adapter. 
 
 
Configurando a interface "Microsoft Loopback Adapter" 
 
Agora que já temos um adaptador de rede, vamos configurá-lo para o uso do SimulationView. O 
simulador usa IPs de rede da mesma forma que os equipamentos reais, sendo assim, precisamos 
configurar 32 IPs válidos e não repetidos, mais um IP para ser usado pelo Server. 
 

1. Dentro do IP configurator na primeira seção Simulator network interface a interface 
Microsoft Loopback Adapter deve aparecer selecionada. Caso nenhuma interface esteja 
selecionada refaça o passo Criando uma interface de rede do tipo Microsoft Loopback 
Adapter. Veja Anexo A para mais detalhes. 

 

 
 

2. Na seção IP Configuration atribua um valor ao campo First IP. Note que este primeiro 
endereço de IP deve ser usado como endereço no Server OPC e não deve ser usado para 
nenhum outro propósito. Este IP é o da interface Microsoft Loopback Adapter. 

 
3. Clique no botão GENERATE IP TABLE para criar uma tabela com 32 IPs sequenciais 
gerados a partir do First IP que foi escolhido no passo anterior. Uma sequência de IPs será 
gerada no campo IP Table. Veja figura seguinte. 
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4. Clique no botão APPLY caso esteja satisfeito com a configuração gerada. Caso contrário, 
volte ao passo 2 para gerar uma nova sequência de IPs. 
 
5. Caso a seção Actual IP Configuration já esteja corretamente configurada com os IPs  
clique KEEP para manter a configuração. Neste caso basta confirmar a operação e clicar 
CLOSE para fechar o IP Configurator. 
 
6. Uma mensagem de confirmação será exibida para garantir que você está certo da sua 
decisão de mudar os IPs, caso tenham sido alterados. Em caso positivo sua nova configuração 
será aplicada à interface selecionada. Na seção Actual IP configuration os IPs correntes são 
mostrados. 
 
7. Uma mensagem de sucesso será exibida indicado que o processo terminou. 
 
8. Feche o IP configurator e execute novamente o SimulationView. 

 
 
Configurando os IPs dos equipamentos HSE da planta 
 
Este procedimento é opcional no SimulationView, pois os IPs para todos os equipamentos HSE da 
planta são configurados automaticamente.  
 
Na tela principal do SimulationView selecione uma área na seção Areas. Todas as áreas do 
database do Studio302 serão listadas aqui. 
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Na seção Simulated nodes selecione o primeiro item da lista. 
 

 
 
Na seção Item configuration no campo Avaliable IP selecione o IP que deseja atribuir ao item e 
dê duplo clique sobre o mesmo. 
 
Selecione os demais itens e proceda como descrito anteriormente para todos os equipamentos 
HSE de todas as configurações.  
 

NOTA 
Lembre-se de não selecionar um IP que esteja atribuído ao NIC do Server no 
System302 ServerManager. 
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Ajustando o System302 ServerManager para trabalhar com a 
simulação 
 
Este procedimento é opcional no SimulationView, pois a ferramenta Setup tool sempre dá a 
opção de configurar o OPC. Caso necessite modificar a configuração manualmente, siga os passos 
descritos nesta seção.  
 
A simulação trabalha com sua própria rede virtual, então é necessário informar ao SYSTEM302 que 
vamos usar esta rede e não nossa rede de automação. Se estiver usando uma licença acadêmica o 
simulador somente executará nesta rede virtual e não é necessária esta configuração. 
 
Para ajustar o System302 ServerManager devemos abri-lo. Clique no ícone System302 
ServerManager - OPC Server Management na barra do Studio302.  
 

 
 

A seguinte janela aparecerá:  
 

 
 

Escolha Network.  
 
Na opção NIC escolha o primeiro IP gerado pelo SimulationView - IP Configurator e clique em 
Apply. Este IP é o da interface Microsoft Loopback Adapter.  
 

 
 
Agora o sistema já está configurado para usar o adaptador de rede virtual.  
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Operação 
 
Start/Stop simulação através do ícone de notificação 
 
Quando o SimulationView está executando o usuário pode iniciar ou parar a simulação através do 
ícone que fica na Área de notificação do Windows. 
 
Simulação parada:  

 
 
Simulação em execução:  

 
 
Para iniciar a simulação ou pará-la, acesse o menu contextual clicando com botão direito no mouse 
sobre o ícone do SimulationView:  
 

 
 
Selecione Stop para parar todas as áreas em execução. 
 
Selecione Start para iniciar todas as áreas do database (áreas devidamente configuradas).  
 
Para verificar se a simulação está ou não sendo executada, além da cor do ícone, uma mensagem 
de notificação também é exibida quando o mouse paira sobre ele.  
 
Simulação em execução: 
 

 
 
Simulação parada: 

 
 
 

NOTAS 
• Iniciando ou parando a simulação pela barra de notificação, o SYSTEM302 continua 

em modo de simulação. Apenas para o processamento dos blocos e da ladder. 
• Toda vez que a simulação for parada e depois reiniciada um download de configuração 

via Syscon deverá ser feito. 
• O status de todos os TAGs do Server OPC, no modo de simulação, são reportados 

com o substatus "Local Override". 
 
 
Limites do SimulationView 
 
Tabela de limites: 
 

Número máximo de equipamentos HSE por bando de dados 32 
Número máximo de blocos funcionais por sessão de simulação 11264 
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NOTA 
Dependendo da aplicação usar o número máximo de blocos e de equipamentos HSE 
pode causar perda de performance do sistema, exigindo que a configuração do 
computador que executa a simulação seja acima da recomendada pela Smar para 
executar o SYSTEM302 sem a simulação. 

 
 
 

Entendendo a tela principal do SimulationView. 
 

 

 
Veja a seguir as partes componentes da janela principal do SimulationView. 
1. Menu principal. 
 
File 

• Exit: Finaliza o SimulationView parando toda a simulação que esteja em andamento. 
 
Simulation  

• Launch the simulation: Inicia a simulação de todas as áreas do banco de dados.  
• Refresh: atualiza lista de áreas. Usado quando uma nova área é inserida no banco de 

dados com SimulationView em operação.  
• Stop the Simulation: Para toda a simulação corrente.  
• Show simulation report: Mostra um resumo do número de equipamentos em 

simulação. Apenas os equipamentos HSE são representados na simulação, para as 
bridges todos os blocos funcionais dos equipamentos ligados em seus canais serão 
simulados na própria bridge. 
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Help  
• Content: Abre o help do aplicativo. 
• About: Mostra a versão do software. 

 
2. Areas 
 
Lista todas as áreas dentro do database atual. Esta lista é adquirida diretamente do banco de 
dados do SYSTEM302. 
 

3. Botão  
Faz com que todos os equipamentos desta área sejam simulados. 
 

4. Botão  
Para a simulação para todos os equipamentos desta área. 
 

5. Botão  
Atualiza lista de áreas. Usado quando uma nova área é inserida no banco de dados com 
SimulationView em operação. 
 

6. Botão  
Abre o configurador de rede. Este aplicativo é usado para configurar o adaptador usado pelo 
SimulationView. Veja o tópico Configurando a interface "Microsoft Loopback Adapter".  
 
7. Nodes 
Lista dos equipamentos simulados dentro da área selecionada em 2. Lista os equipamentos ligados 
ao canal HSE da configuração. Apenas os equipamentos HSE são representados na simulação, 
para as bridges todos os blocos funcionais dos equipamentos ligados em seus canais serão 
simulados na própria bridge. 
 

8. Botão  
Inicia a simulação do equipamento selecionado em 7. 
 

9. Botão  
Para a simulação do equipamento selecionado em 7. 
 

10. Botão  
Atualiza a lista de equipamentos da área selecionada em 2 e procura por processos que estejam 
rodando em segundo plano. 
 

11. Botão  
Abre o help do aplicativo apontando para o tópico "Configurando IPs para os equipamentos". 
 

12.  Botão  
Aplica o IP selecionado em 13 para o equipamento selecionado em 7. 
 
13. Available IP 
Lista todos os IPs do adaptador de rede usado para simulação. 
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Visualizando a simulação 

Para visualizar a simulação de sua área, na barra de ferramentas do Studio302 clique em  - 
SimulationView - Strategy Simulator.  
 

Execute o Syscon clicando em  na barra de ferramentas do Studio302. Ao entrar no 
ambiente do Syscon verifique se está selecionada a opção de comissionamento automático. No 
menu principal selecione File →Preferences. Clique na aba Simulation e a seguinte janela abrirá: 
 

 
 
 
Por default, a opção Automatic Commissioning já está selecionada. Deixe assim, caso não 
queira fazer o comissionamento manualmente.  
 

IMPORTANTE 
O processo de comissionamento faz a correlação entre os equipamentos reais e os da 
configuração e deve ser realizado toda vez que uma planta é colocada online. 
Para a simulação este procedimento é opcional, podendo ser usado para treinar 
operadores para este procedimento. 

 
 
Abra a área a ser simulada na interface do Studio302. O arquivo será aberto no Syscon. Em 

seguida ative o modo Online clicando em  na barra de ferramentas do Syscon. Uma janela 
semelhante à seguinte estará aberta. 
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O modo Simulation é indicado na barra de título pelo texto (Simulation) ao lado do nome de sua 
área. É indicado também em baixo da janela por Simulation Mode. Trabalhe normalmente como 
se estivesse no ambiente real. Para maiores detalhes sobre o funcionamento do Syscon, consulte 
seu manual. 
 
Caso o IP configurado na simulação seja diferente do NIC aparece a seguinte mensagem de erro 
logo quando o Syscon é colocado no modo Online: 
 

 
 
Pare a simulação, vá ao System302 ServerManager e configure corretamente o IP da interface 
Microsoft Loopback Adapter. 
 
A lógica de controle também pode ser simulada no LogicView for FFB. Edite a lógica a partir do 
Syscon que já deve estar em modo de simulação. Tanto o Syscon quanto o LogicView for FFB 
devem estar em modo Online. 
 
Uma janela semelhante à seguinte abrirá: 
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O modo de simulação é indicado na barra de título pelo texto SIMULATION. É indicado também 
pela cor de fundo da área de trabalho que pode ser alterada em Tools →Options. A seguinte 
janela abrirá: 
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Na opção Simulation Color altere a cor do fundo. 
Caso a licença seja acadêmica, ao entrar em modo online no LogicView for FFB não estará 
habilitada a conexão a server remoto. 
 
Trabalhe normalmente como se estivesse no ambiente real. Para maiores detalhes sobre o 
funcionamento do LogicView for FFB, consulte seu manual. 
 
 

IMPORTANTE 
Caso o usuário queira simular uma estratégia de controle ainda não configurada para 
tal deve sair do modo de simulação e, somente depois disso, configurar a nova área. 
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SOLUCIONANDO PROBLEMAS 
 
 
Se estiver enfrentando alguma dificuldade com o simulador existem alguns tópicos que podem te 
ajudar: 
 
1. Iniciei o SimulationView e recebi a seguinte mensagem:  
"There is no loopback ethernet interface configured! The SimulationView Network configurator will 
be executed. Note that SimulationView will be closed and must be reinitiated after the 
configuration."  
Esta mensagem indica que nenhum adaptador de rede do tipo "Microsoft Loopback Adapter" foi 
configurado. Siga as instruções em Criando uma interface de rede do tipo "Microsoft Loopback 
Adapter” para solucionar o problema. Logo em seguida execute novamente o SimulationView.  
 
2. Iniciei o SimulationView e recebi a seguinte mensagem:  
"There are unconfigured equipments\n\nPlease Access SimulationView and configure IP for those 
equipments:"  
Nesta mesma mensagem é mostrada uma lista de equipamentos (PD Tags). Esta mensagem 
indica que existem equipamentos ainda sem IPs atribuídos. Siga as instruções em Configurando 
os IPs dos equipamentos da planta para solucionar o problema.  
 
3. Estou com a simulação executando, mas no Syscon todos os equipamentos estão sem 
comunicação.  
Verifique na "Área de notificação" do Windows se o ícone do SimulationView está presente.  
Passando o mouse sobre este ícone ele deve mostrar a mensagem SimulationView (running). Caso 
mostre a mensagem SimulationView (stopped) siga as instruções do tópico Start/Stop simulação 
através do ícone de notificação.  
 
4. Iniciei o SimulationView e recebi a seguinte mensagem:  
Título “Fail configuring IP!”  e a mensagem “There are no free IP to use! The selected network 
adapter doesn't have the number of IP necessary to simulate your entire database. Or you are trying 
to simulate more than 32 equipments at the same time.”  
 
Primeira hipótese: Você selecionou várias áreas para simular e o número de equipamentos HSE 
somados ultrapassou 32. Veja o tópico Limites do SimulationView 
 
Solução: Feche o SimulationView, vá até o Studio302 e selecione apenas as configurações 
necessárias no momento. Tente novamente iniciar o SimulationView.  
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Anexo A 
 

A.1 

CRIANDO UMA INTERFACE DE REDE DO 
TIPO "MICROSOFT LOOPBACK 
ADAPTER" 
 
Siga os passos seguintes para criar uma interface de rede do tipo Microsoft Loopback Adapter, 
usando o sistema operacional Windows 10. 
 
Passo 1 – Clique com botão direito do mouse em Iniciar e a seguinte janela aparecerá: 
 

 
 
Passo 2 – Selecione Gerenciador de Dispositivos. 
 
Passo 3 – Na janela Gerenciador de Dispositivos, selecione Adaptadores de Rede. Veja figura 
seguinte. 
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Passo 4 – Clique na opção Ação do menu da janela Gerenciador de Dispositivos. 
 
Passo 5 – Selecione a opção Adicionar hardware herdado. Veja figura abaixo: 
 

 
 



Apêndice A – Criando uma interface de rede do tipo Microsoft Loopback Adapter 
 

A.3 

Passo 6 – A seguinte janela abrirá. Clique Avançar. 
 

 
 
 

Passo 7 – Selecione a opção Instalar o hardware que eu selecionar manualmente em uma lista 
(avançado). Em seguida, clique Avançar. 

 

 
 
 
Passo 8 – Selecione Adaptadores de rede na lista que aparecerá e, em seguida, clique Avançar. 
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Passo 9 – Selecione Microsoft na lista de fabricantes. 
 

 
 

 
Passo 10 – Na lista dos modelos, selecione Microsoft KM-TEST Loopback Adapter e, em 
seguida, clique Avançar. 

 



Apêndice A – Criando uma interface de rede do tipo Microsoft Loopback Adapter 
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Passo 11 – Para começar a instalar o novo hardware clique Avançar novamente. 
 

 
 

Passo 12 – A instalação está completa. Clique Concluir para sair do assistente de instalação. 
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